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Foreword

ack in the early 1990s, people in the former Eastern Bloc countries were just getting

used to their new freedoms. I was at university, and one of my lecturers commented that

after so many years of state-controlled media, television was their window on the world.

It’s something that’s stuck with me, and I think that if television can be a window on the
world, then perhaps Photoshop is a window on the imagination.

Round about the same time, in the early 1990s, the first versions of the program were being
developed very much with photo editing in mind. I remember getting my first Macintosh and installing
an old version of doubtful legality. (Hey, I was just a student!) Having scanned in some photos of a
fellow journalism student, and cropping his head into a triangle shape, I began duplicating it across the
document and applying different combinations of sharpen, blur, and posterize filters to each version of
his now sorry-looking face.

I knew what I created wasn’t at all good but others were impressed for roughly 15 minutes, which
made me feel like I'd been a bit of an Andy Warhol—for just about that long.

Fast forward 5 or 6 years and while I still couldn’t create anything from my own imagination using
Photoshop, or even crayon for that matter, I had discovered a man who could. Derek Lea was producing
illustrations for us on Computer Arts magazine, the likes of which we’d never seen. A colleague of
mine at the time suggested that not only should we ask Derek to create an image for us, but what if we
asked him to produce a step-by-step article, complete with screenshots, showing how his piece was
developed. I called Derek up, he accepted, and I promised him a beer the next time I was in Toronto.

We didn’t realize it at the time but we had unleashed a new force in the world of art and
illustration. Derek was showing our readers how they could use Photoshop creatively and artistically.
Pretty soon other magazines, both within our own group and rivals, picked up on Derek’s talent. He’s
gained illustration clients around the world, written books, and won awards.

His edge is that he won’t stand still, and this new edition of his book brings the proof. Despite the
magic of Photoshop, digitally retouched images often leave viewers cold, and to combat this, many
creatives bring natural media elements into their artwork. For a number of years Derek has been
enthusiastically mixing media like watercolors and inks, papers, paint on wood—not to mention found
objects—and photographs. The skills involved in combining real-world richness with the flexibility of
Photoshop are at your disposal in the new section in this edition.

Some of the commissions I’ve sent Derek over the years appear in these pages, where you can
follow how they were made. Once again it’s been an honor to write this foreword. As for my own
Photoshop skills, I figured I’d quit while I was ahead back in the 1990s. Derek Lea is your man when it
comes to image creation—I stick to the words.

Garrick Webster

Writer and magazine editor

(Former editor of Computer Arts, 3D World, and
Cre@te Online)
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Introduction

Photoshop and me

When I first discovered Photoshop, it was 1993. I started a new job as a designer at a clothing
company. It was a really horrible job, but at least they bought me a new scanner. In those days a lot

of scanners came bundled with Photoshop. The first thing I did when I opened the scanner box was to
take the Photoshop 2.5 disks and put them in my jacket pocket. When I got home that night, I installed
Photoshop on my Mac Ilci at home, and my life began to change. I know it sounds ridiculous, but in
hindsight, that was a pivotal moment for me.

I had been working in Adobe Illustrator for a few years by then, but Photoshop seemed like a
bottomless pit of creative possibilities. There was so much I could do that at times I didn’t even know
where to start. I began spending hours and hours every night just experimenting. As a result of this
endless experimentation, I gained enough knowledge and experience to successfully land myself a
position as a professional retoucher at a photography studio. This meant that I could spend all day,
every day, working in Photoshop.

The problem with hiring artists to do retouching work is that although they may be good at it,
they get bored. I was no exception. Yes, I was getting good at making cheap jewelry look expensive,
and making static cars look like they were in motion, but the novelty of those achievements wore off
quickly. Frustrated and bored with my work, yet still in love with Photoshop, I began to deviate from
working with photography in the classic sense. On my own time, I started to experiment with different
methods to create actual artwork within Photoshop. I began entering contests and then winning awards.
The next thing I knew, I had art directors calling with commissions and just like that I became an
illustrator. Illustrating digitally allowed me to work all day, every day, within Photoshop. But this time,
I wasn’t limited to retouching photographs anymore.

Another pivotal point came when my work was noticed by the world’s best-selling creative
magazine: Computer Arts. 1 was featured in Computer Arts and developed a working relationship with
them that continues to this day. They started asking me to not only illustrate but to write for them as
well. Working with Computer Arts really lit a fire under me creatively. The commissions from them
constantly demanded new things and challenged me both creatively and technically. I cannot stress the
importance of my work with them enough, as my contributions to Computer Arts eventually provided
the starting point for much of the content you’ll find within this book.

Why does the world need another Photoshop book?

As a Photoshop neophyte in the early 1990s, I was always hungry for resource materials. I would scour
the local bookstores looking to be informed and inspired. What I noticed then was that Photoshop
books, more or less, fell into one of two categories.

There were books that contained beautiful collections of digital art. These books would inspire me
with their rich and thought-provoking images, but they lacked detailed instruction on how to achieve
those results. Apart from artistic inspiration, these books really didn’t offer much to a guy who wanted
to learn how.

vii
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The other option was books of a more instructional nature. Generally offering lots of information,
instruction, helpful hints, and tips, I found these books always lacking in the inspiration department.
Granted, I found some useful information in these books, but more often than not, I had to read the
chapters on faith alone. Basically, I would hope that afterward, I could do something remarkable on
my own with the knowledge they contained, because the imagery within those books never really
impressed me.

What you hold in your hands is the book I always wanted. My aim is to inspire you as well
as inform you. I have spent a great deal of time perfecting a variety of artistic styles and working
practices in Photoshop. And I have also spent a great deal of time producing images that I hope will
inspire you to learn. This book is for those of you who not only appreciate art but also want to know in
explicit detail how to create it on your own. There seems to be an infinite amount of Photoshop books
out there, and many of them are excellent. However, I still haven’t found that perfect book that inspires
as much as it instructs. After all these years I came to the conclusion that the book I was after didn’t
exist, so I decided to write it myself. If you are reading this right now, chances are you’ve been looking
for the same thing too.

How to use this book

This book is a series of projects. Each chapter opens with an inspirational image, and the step-by-step
instructions required to re-create that image immediately follow. You’ll find all of the resource files
needed to create each image available for download at www.creativephotoshopthebook.com. This book
is written in a nonlinear manner, meaning that you do not have to start at the beginning and progressively
work your way toward the end. Each chapter is independent of the others, so you can start wherever you
like and move around randomly from one chapter to the next. Pick a chapter with an image that inspires
you and follow it through to fruition; it’s as simple as that.

This book includes variety not only in style and subject matter but also in technique and working
methods. You’ll find a vast array of tools, features, and options as you work your way through.
Fundamental and essential working methods will appear repeatedly, but each chapter definitely has
something unique to offer in terms of both technique and artistic style.

A guitar teacher once told me that the best way to teach someone to play is to get him or her
working on something they like straightaway. Forget showing them all of the chords or notes when it
makes no sense to them yet, just get them to do something they’re interested in. That is the approach I
have taken here. You’ll get your feet wet while producing something worthwhile, and at varying stages
in the process you’ll begin to understand the value of what you’ve done. When knowledge begins to fall
into place as you work, and it most certainly will, the proverbial light comes on. At that point, you’ll
really begin to see the potential of what you’ve learned. So don’t limit yourself to simply finishing the
chapters in this book. Try to think of ways that you can take what you’ve learned from each chapter and
use it to create original artwork of your own.

Basic Photoshop knowledge

Creative Photoshop is not a beginner’s guide, nor is it exclusively for experts. It falls into that
mysterious category in-between often referred to as intermediate. The idea of what an intermediate
user does or does not know will often vary depending upon whom you’re talking to. I have written this
book assuming that you, as the reader, know your way around Photoshop and understand the basics.

I am assuming that you have an idea of what the tools do, what layers are, the difference between
vectors and pixels, etc.


http://www.creativephotoshopthebook.com
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Numerous functions and tools within Photoshop will be explored in depth, via the step-by-step
instructions in the following chapters; however, you’ll need to know the basics to follow along with
ease. For those of you who possess more ambition than Photoshop know-how, I can certainly relate.
As a beginner, [ would’ve picked up this book too. My advice to those who are just starting out is to
get familiar with the Photoshop Help menu. Any time you get stuck, you can do a specific search. The
results will explain anything you need to know about using a tool or function in Photoshop. Once you
find what you’re after, you can continue following along where you left off.

Expert tips

In addition to step-by-step instruction and inspirational imagery, you’ll find hundreds of expert tips
scattered throughout this book. Some of the tips pertain to the instructions on a particular page, but
many are additional hints and pieces of advice which will prove useful for almost anything you set out
to do within Photoshop. Feel free to flip around the book and examine different tips, just as you would
randomly flip from chapter to chapter. Tips are divided into six categories, represented by different
icons as follows.

Shortcuts

These time-saving tips will shave hours off of your time spent working. Whether it is a
keyboard command or a quicker way of doing something, these tips will allow you to focus
on creating, rather than spending all of your time executing certain tasks the long way.

Info

These tips contain useful tidbits and extra information that may not be addressed in the
step-by-step instructions within each chapter. Or additional, more detailed, information is
provided to accompany a specific stage in the process.

o

Download files
These tips will point you toward the specific files required to follow along. All project files
are available for download in the project files section of the Creative Photoshop Web site.

Caution
Be extremely careful when you see this tip. You are being warned of potential pitfalls and
must carefully pay attention to prevent things from going horribly wrong.

CS4
This tip draws your attention to functions, features, and/or tools that are available only
within Photoshop CS4.

Creative tips

Creative tips provide valuable hints and advice regarding the artistic process of creating
within Photoshop. Everything from unconventional tool usage within Photoshop itself
to hints on how to extract resource materials from the physical world surrounding you is
included here.

Qo> NC
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Become part of the Creative Photoshop community
Your exploration into the artistic side of working with Photoshop does not end with this book. Visit
the Creative Photoshop Web site and explore the user forum. Share knowledge with, and ask questions
of other readers. Be sure to post your finished images within the user forum for everyone else to see.
Submit the works you’ve created by following the chapters here, or post your own work, showcasing
your new creative Photoshop skills. Also, don’t forget to investigate the cover challenge on the Web
site, discussed in the final chapter of this book.

Join the Creative Photoshop community at www.creativephotoshopthebook.com.


http://www.creativephotoshopthebook.com
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Chapter 1: Painting in Photoshop

;"ainting in
Photoshop

he simulation of natural media is always a tricky prospect when working digitally.
There are endless filters and niche applications out there that promise convincing
results. However, quick fixes and prefab effects often are disappointing. When
you are painting digitally, the old saying “If you want something done right, do it
yourself” comes to mind, and this is exactly what you’ll learn to do in this chapter. Photoshop
may not be the first application that you think of when you’re setting out to paint. However,
a closer look at what Photoshop has to offer in terms of paint tools will reveal that everything
you need is there. The tools and features at your disposal are a bottomless pit of options and
flexibility. There is a little something in there to suit any user or simulate almost any artistic
style.

Equally as valuable when it comes to painting are all of the image compositing tools at your
disposal. A successful painted result relies not only on actual brush strokes but also on the way
the image is carefully constructed within Photoshop. In this chapter, rather than predictably
going through every single appropriate tool and feature like a list, you will focus more on
establishing a logical method of working as well as explore the techniques involved in building
up a realistic-looking painted file.

You'll need a very basic understanding of the Layers palette and
Photoshop’s paint tools. You don’t need to know anything about image

2 editing tools or selection tools or anything like that. We are simply
n OI 5 discussing the act of painting digitally in a methodical way.

DIFFICULTY




Part One: Drawing and Painting

What you’ll learn in this chapter

Creative Techniques and Working Methods

Think of Photoshop as your digital studio

When it comes to working, Photoshop nicely addresses the issue of translating your
traditional tools from within the tactile realm into their digital counterparts. The
Swatches palette can be thought of as your artist’s palette, allowing you to store all of
the colors you're going to use. The Tool Preset picker is a fantastic place to store your S
brushes as you create them, allowing you to instantly switch back and forth between
your own custom tools.

When you decide to use Photoshop as your digital paint tool, you'll never run out o Chat Wncer
of paint or canvas, you'll never misplace your favorite tool, and you'll never have to o v al
worry about cleaning your brushes at the end of the day. As you work your way through i
this chapter, not only will you learn to paint methodically, but you'll also gain an -
understanding of the organizational potential within Photoshop. . pronmerern
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o oustom bewih 2

4 Curvern Tool Oniy

Photoshop Tools, Features, and Functions

e —

A ] The Brushes palette

DI - | ; . | . : E The Brushes palette is an excellent resource for crafting convincing and

T Anninnn customized brush looks. Whether you want to simply tweak a preset brush tip or

e IE IS it create something entirely new with which to paint, everything you need is there.
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e Painting on layers
- L | mecgrowan @ Layers are invaluable tools when painting too, as they allow you to separate
& applications of paint, giving you the flexibility to edit specific painted regions

and colors without affecting the rest of your image. In addition to editing

- biend backgra @) advantages, layers also allow you to easily and gently build up brush strokes
within your file, resulting in a beautiful and authentic appearance.

@
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Chapter 1: Painting in Photoshop

PART ONE: Getting ready to paint

1 Open up the sketch.jpg file. Starting with a
I sketch is an essential part of the process when
| painting in the tactile realm, and working in
| Photoshop is no exception. The main difference
r_/‘ here is that in this case the sketch is scanned
Ta rather than being drawn directly onto the
canvas. Once you've opened up the sketch,

[ — select the Brush tool. In the Brushes palette,
===t s ®a cnable the Smoothing option at the left. We're
s L5 DS going to work with this option enabled for the
el e % w1 entire chapter because smoothing guarantees
o & w e« Bl that your brush strokes contain nice, smooth
7P ;;'E.':[ b ‘ ‘| curves.And that. is an essential .quglity when you
.E‘.._-E . i > {' E g. want your painting to look convincing.

Default brushes
Although Photoshop is equipped with a plethora of excellent brush libraries, we're going to focus on some simple default
brushes capable of producing exceptional results.

a The spatter brushes may not look like much within a vast list of presets,
but these simple clusters of spots are very useful. There are a number of
different tips and sizes to choose from. Regardless of which option you
go with, any spatter brush gives the effect of using a brush with some
stray dry bristles sticking out around the edges. Painting over the top

of the colored regions of the canvas with a spatter brush allows you to
create a bristled, tactile effect.

b The chalk brushes are denser than the spatter brushes but equally

as useful. Strokes created with chalk brushes do not have any stray
bristles sticking out the sides, but they do provide a nice rough effect
at the beginning and at the ending of each stroke. They are ideal for
establishing basic, yet convincing, colored regions within your painting.

¢ The Dual Brush option is an excellent tool that allows you to combine
two different brushes within a single tip. Why do we point out this single
feature amid a sea of others? Well, using the Dual Brush option allows
you to quickly and easily combine two brush tips to create a new one.
We'll explore this feature in detail using custom brush tips later in the
T _ 38 @ & chapter.




Part One: Drawing and Painting

@ Project files

All of the files needed to follow
along with this chapter and create
the featured image are available for
download on the accompanying Web
site in the project files section. Visit
www.creativephotoshopthebook.com.

m Saving swatches

When you hit upon a combination of
swatches you like, it is possible to save
them for use at a later date. Simply
choose the Save Swatches option

from the Swatches Palette menu. This
option allows you to name and then
save your swatches as a library file.
Save this file anywhere you like.You
can always reload your saved swatches
by choosing the Load Swatches option
from the Swatches Palette menu and
navigating to your saved preset file.

If you place your library file in the
presets/swatches folder within the
Photoshop program folder, the library
will appear within the list at the bottom
of the Swatches Palette menu the next
time you launch Photoshop.

Preset Manager
Preset Type: Swatches E » ﬁ
Load. )
Save Set.
| Rename
Delete

2 Now, the next thing we're going to do is establish the Swatches palette as our
paint palette and fill it with our own set of colors unique to this painting. By doing
this, we can return to the Swatches palette and select one of our custom colors
at any point later on. Choose Edit > Preset Manager from the menu. Choose
Swatches from the Preset Type menu. The Preset Manager can also be accessed
via the Swatches Palette menu. If you access it via the Swatches Palette menu, the
Preset Type is automatically set to Swatches. When the swatches appear, click on
the first swatch and then Shift-click on the last swatch. This will target all of the
swatches. When all of the swatches are targeted, click on the Delete button. After
they're all deleted, click on the Done button to exit the Preset Manager, and you'll
notice that the Swatches palette has been emptied.

Color Swatch Name

. Name: Swatch 1 I

3 When the Swatches palette is empty, click on the Foreground Color swatch in
the toolbox to access the picker. Select a new foreground color from the picker
and click OK. Move the mouse over the empty area of the Swatches palette. You'll
see it temporarily switch to a paint bucket. When you see the paint bucket, click to
add the new color to the Swatches palette. Name your new swatch when prompted
and then click OK. After naming, the new color is added to the Swatches palette.
Use this method to add a variety of colors to the Swatches palette. This method is
an excellent way to exercise a little forethought, establishing a predefined color
scheme to work within before you begin painting.


http://www.creativephotoshopthebook.com
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Hiacmiea 4 After selecting the Brush tool, choose the largest Chalk Brush preset from the Brushes
S palette. In the Brush Tip Shape section of the Brushes palette, increase the diameter
IS : of the brush.You want a large brush here because, first, we want to cover most of the
! ~ background with color, giving us a new base color other than white. Leave the spacing
~ option enabled but reduce the amount to 1 so that there is no stepping or spaced brush
marks present within your strokes. Choose a foreground color from the Swatches palette
) and click the Create a New Layer button in the Layers palette.

PART TWO: The background and figure outlines

/
Brush angles

The chalk family of Brush presets is

a perfect example of presets that are
ideally suited to right-handed people.
Generally, right-handed people paint
from bottom left to top right, or from
top right to bottom left. The angle of the
Chalk Tip presets ensures that right-
handed painters working in the typical
manner get the majority of the available
brush width from each stroke. If you're
left handed, try rotating the angle in

the Brushes palette.You can specify any
angle you like, and this angle will likely
vary from preset to preset. Try starting

5 Target your new layer in the Layers palette and begin to paint a series of strokes somewhere between 37° and 45° and
on the new layer. Focus on areas that are the background, as indicated in the experiment from there. Besides rotating
sketch. Just. start painting some st'rokes; (jon't cover the line work of the sketch on the angle, you can enable the Flip X
accommodate different regions on the canvas. For open areas of the background, brush tip horizontally, creating a mirror

use a brush of very large diameter; for tighter regions, such as between the small image of the brush tip.
figure’s fingers, use a brush of much smaller diameter.
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Canvas rotation

In addition to altering the angle of

the brush as you paint, Photoshop

GS4 provides you with the ability to
rotate the canvas. This feature helps

to lend an intuitive feel to the process
as you work. First, ensure that in the
Performance section of the Photoshop
preferences, you have enabled OpenGL
drawing by checking the appropriate
checkbox. Then simply select the Rotate
Ganvas tool from either the toolbar or
the Application bar. After that, all that
you need to do is click and drag on
the canvas to rotate it. Also note that
you can enter a numeric value for your
angle or reset the view instantly in

the Tool Options bar when this tool is
selected.

Locking layers

As your file gets bigger, it will become
gasier and easier to accidentally

paint on the wrong layer. To prevent
accidentally painting over the wrong
layers, simply lock the layers that aren’t
in use in the Layers palette. Choose

the Lock All option just to be safe, and
remember you can always go back to
an old layer and edit it; you just need to
unlock it first.

6 Choose a different color from either the picker or one of your own custom
swatches and paint the background area at the bottom of the canvas. When you're
finished, choose a black foreground color and create a new layer in the Layers
palette. Target the new layer and use the brush to begin tracing the black outlines
of the underlying sketch on this new layer. Reduce the opacity of your brush in the
Tool Options bar to 50% so that there is a translucent effect as you paint small
strokes over the top of each other.

7 Glick on the Brush Tip Shape option from the left in the Brushes palette. Use

this area often to vary the angle of the brush as you paint. You'll need to tweak the
angle frequently when painting around areas such as the heads of these creatures.
If you don't adjust the angle at times, there will be areas where the strokes appear
too thin compared to others. Click on Shape Dynamics in the Brushes palette to
enable Shape Dynamics and then on the Angle Jitter Control menu to view the
options.



8 Choose the Direction option from the Control menu, but leave the angle jitter
amount set to 0.This setting causes your brush to base the angle of the brush
tip on the directions of your stroke as you paint them. Because we still want

a somewhat smooth edge to the strokes, the amount is set to 0. The more you
increase the amount, the rougher the edges of the strokes will appear. By simply
enabling the Shape Dynamic function, you can save yourself the trouble of having
to constantly adjust the angle as you paint. Finish painting the black outline.
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9 Reduce the opacity of your brush to 26% and then open the Tool Preset picker
at the far left of the Tool Options bar. Click on the Create New Tool Preset button.
When you are prompted, name the tool “Chalk Blender.” Disable the Include Golor
option and click OK.This brush is now added to the preset picker, with all of the
Brushes palette options and dynamic functions intact. You can access it directly
from the preset picker from now on. Create a new layer in the Layers palette and
ensure that it is targeted.

Chapter 1: Painting in Photoshop

m Current tool only

In the Tool Preset picker, you will see an
option for the current tool only. Enable
this option for the duration of this
chapter. Enabling this option will show
only presets for the Brush tool rather than
the saved presets for all of Photoshop’s
tools. Because we're only using the Brush
tool from here on in, there is no need to
view other tool presets.

Canvas rotation shortcuts

You can quickly access the Canvas
Rotation tool by pressing the “r” key. After
rotating, press the “esc” key to return the
canvas rotation to its original state.Also,
you can simply hold down the “r” key
while you're painting, which will allow
you to temporarily access the Canvas
Rotation tool. You can click and drag to
rotate and then, when finished, release
the “r” key to return to the Brush tool.

@ Brush presets versus tool
presets

When you save one of your current
brushes as a tool preset, not only are all
of your Brushes palette options saved
within the preset, but all of your Tool
Options har items are also included.

[f you wish to save a Brush preset
without the Tool Options bar items
being included, do so via the Brushes
palette menu. Choose New Brush preset
from the Brushes Palette menu to save
your current brush, adding it to the

list of presets in the Brushes palette,
independent of the Tool Options bar items.
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Using a stylus

You can indeed paint with a mouse, but
it can be a laborious task at times. It
is certainly not the most intuitive way
to paint. If you plan on doing much
painting in Photoshop, it is definitely
worth investing in a pressure-sensitive
tablet and a stylus. Drawing with a pen
is much more intuitive and easier than
drawing with a mouse. Also, there are
a number of dynamic brush functions
that work with pressure sensitivity, tip
angle, and stylus rotation. So yes, you
can complete this chapter and learn
about painting by using a mouse. But if
you really want control when you paint,
a stylus is a worthwhile investment.

10

10 Use your current brush, set to 256% opacity, to blend the background fill colors
together on the new layer; this is precisely why we named the preset “Chalk Blender.”
Start by painting strokes over the areas where light and dark colors meet. Paint dark
strokes over light areas, and vice versa. Go back and forth painting like this until
colors begin to blend together. Change the direction of your brush strokes often as
well as the size of your brush tip. Also, if using an opacity of 26% does not give you
a blend effect that is as smooth as you'd like, try reducing it when necessary.

e MO 6. 0 & 9 4

11 Now add different colors from the Swatches palette into the background here
and there, using the same brush on the current layer. Try initially adding them using
a higher brush opacity setting, and then blending them into the background using
lower opacity settings. A quick way to work is to Alt(PC)/Option(Mac)-click on areas
of the canvas to sample color rather than always returning to the Swatches palette.
This technique is especially useful when blending as you can sample “in-hetween”
colors. Using this method, if you happen to sample a foreground color that you like,
feel free to add it to the Swatches palette so that you can access it later.
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12 In the Brush presets section of the Brushes palette, select the spatter 59
pixels Brush Tip preset. Now, in the Brush Tip Shape section of the Brushes palette,
adjust the angle of the brush tip until you've achieved the roughest looking stroke
possible. In the Tool Options bar, set the opacity of the brush to 35% and the flow
value to 16%. Save this new brush as a tool preset and name it Spatter Rough.
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13 Create a new layer and use your newly created tool preset to paint over areas
of the canvas on this layer. Increase or decrease the opacity as required and use
colors from the canvas or the Swatches palette. The goal here is to paint with the
new brush over areas that look very smooth. Because of the brush tip and very

low flow setting, the resulting strokes will add a rougher, more textured feeling to
the areas you paint. Using large brush strokes and bold colors will pronounce the
rough effect. Use this effect sparingly as it can tend to overpower an illustration.

: @

Chapter 1: Painting in Photoshop

While opacity controls how transparent
or solid your strokes will appear on
your layer, it is the flow setting that
controls how much paint is deposited
within a brush stroke as you paint.
Reducing the flow drastically, as

we've done here, will make the brush
stroke look dryer because less paint
is deposited. Increasing the flow will
cause the bristles that make up the
brush stroke to be less pronounced, as
the stroke is heavier with paint and the
space between the bristles will fill in.

11
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14 Open up the brush1.jpg file. Choose Edit>Define Brush preset from the menu. Name your
brush and return to the working file. Choose your new custom brush tip from the end of the
list in the Brush Presets section of the Brushes palette. In the Brush Tip Shape section of the
Brushes palette, set the spacing to 1. In the Tool Options bar, set the opacity to 50% and the
flow to 16%. Save this brush as a new tool preset. Use this same method to open up brush2.
ipg and brush3.jpg and save them as new tool presets, using the same spacing, opacity, and

flow settings.

Now we'll explore the Dual Brush function in the Brushes palette, creating entirely new brushes from combinations of custom

brush tips.

1 Choose your first custom brush
from the Tool Preset picker. Then,

in the Brushes palette, click on the
Dual Brush label at the left side of
the palette to enable the Dual Brush
function and access the settings.
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2 Choose your second custom brush
tip from the Tool Preset picker.
Enable the Random Brush Flip option
at the upper right corner and set
the mode to multiply. Increase the
spacing to about 20%; you'll notice
that it looks like a chalk pastel
stroke in the preview.
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3 Leave the opacity and flow at
their current settings in the Tool
Options bar and then add this
new dual brush to the Tool Preset
picker. Because it looks like a
chalk pastel, go ahead and name
it something appropriate.
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m Defining brushes

A e s

15 Now that you have added three new custom brushes and a new dual brush to the
Tool Preset picker, use them to paint some rough strokes on this layer. Just because
the presets contain embedded settings for opacity and flow, that doesn’t mean that
you can't change them each time you use them. Use a variety of colors, brush sizes,
opacity, and flow settings to introduce some very real and tactile feeling brush
strokes on the current layer. Again, ensure that you do not overdo it as these new
brushes, which produce such distinct strokes, can visually overpower the softly

blended background quite easily.

When we created custom brushes from
images previously, the images were
black and white only. However, you can
use a color or grayscale image as well.
The advantage to using black and white
is that you can get a good idea of how
your resulting stroke will look from

the image used to define the brush.
Black areas will deposit paint and white
areas will not. A grayscale brush tip will
deposit paint according to the density
of black it contains. Color images are
converted to grayscale when you define
brush tips from them.
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16 When you're finished, target the top layer and then Shift-click on the layer directly above
the background layer in the Layers palette. This will target all of your paint layers. Choose
Layer >New > Group From Layers from the menu to add them to a group. Because we're
going to start painting the other image components, this grouping of layers will help us keep
things separate and organized. Create a new layer for the base color of the figures. In the
Brushes palette, choose one of the default chalk brush tip presets. Ensure that Smoothing is
enabled, and in the Brush Tip Shape section of the palette, reduce the spacing amount to 1.

13
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PART THREE: Painting the figures

17 In the Tool Options bar, set the opacity of the brush to 100% and the
flow to 50%. Add this brush to the Tool Preset picker and name it “base
color,” as we'll be using it to create a flat, colored base for the figures
and the stars. Use this brush to add flat color on the new layer in all empty
regions of the figures and the stars. Choose colors from the background
via the Eyedropper or select them from the Swatches palette. Increase or
decrease the size of the brush tip as necessary.

Brush size
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When you have a brush selected, a
quick way to increase or decrease

the brush size incrementally is to

use the square bracket keys on the
keyboard. Press the “]” key to increase
the diameter, or press the “[” key to
decrease the diameter. This method is
great for adjusting size on the fly.
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The brushes used to create this
chapter’s painting are in the same
archive as the rest of the project files.
You can load the brushes by choosing
the Load Tool Presets option from the
Tool Preset picker’s Palette menu.
Navigate to the aforementioned file and
these brushes will become available in
the Tool preset picker.
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18 Create a new layer and select the Chalk Blender preset that you created earlier
from the Tool Preset picker. As you did earlier with the background, blend the
colors beneath this layer together with the Chalk Blender preset on your new layer.
Hold down Alt(PC)/Option(Mac) to quickly sample colors from the canvas and then
paint with your newly sampled colors in the appropriate areas until sharp areas of
color begin to blend together on this layer. Feel free to alter brush size and opacity
as required. Also, feel free to add new areas of color on this layer to indicate
highlights and shadows.
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19 When you are finished adding colors and creating a blending effect on this
layer, create a new layer and target it in the Layers palette. Select your Spatter
Brush preset from the Tool Preset picker. Now use the spatter brush to paint some
light, yet rougher brush strokes over your recently blended areas on the new layer.
Use colors sampled from the canvas or from the ever-growing amount of custom
swatches in the Swatches palette. Vary the brush size and opacity as needed.

You probably want to leave the flow setting fairly low so that the bristles remain
pronounced in each stroke.

Chapter 1: Painting in Photoshop

Brush opacity

When you are working with the Brush
tool, a quick way to alter the brush
opacity is to simply use the number
keys on the keyboard as you paint. Just
type the opacity value you're after, and
it will automatically change in the Tool
Options bar.
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20 Now use your three custom brushes as well as your dual brush to really add a sense
of roughness to the figures and the stars by painting with them on the current layer. Vary

size, color, and opacity as needed. Also, if you feel like experimenting, yet are worried

about making a mistake on your current layer, go ahead and create another layer to work

on. This way, if you like the effect, you can keep the layer. If you don't like it, you can
always delete the layer or even reduce the opacity to lessen the effect.

15
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21 Now, the painting techniques that you've

used so far are certainly successful in creating

a realistic painterly effect. However, when
painting digitally, no matter how convincing
your brush strokes are, it is the smooth and
perfect surface that ruins the authenticity
you've tried so hard to achieve. In order to
remedy this, it is often helpful to involve
something genuine. Open up the painting.jpg

file. This file is a desktop scan, in grayscale, of
a section of an oil-painted canvas. We're going
to add this to our painted file to make use of the

canvas texture and the cracked paint effect.

m Saving tool presets

PART FOUR: Realistic canvas texture

LAYERS

T

To save all of the tool presets that
you've created from existing brushes as
well as custom brushes you've defined
from image files, launch the Preset
Manager. Ghoose Tools from the Preset
Type menu and click on one of your
own brush tools. Hold down the Shift
key and click on the remaining brush
tools you created. When they are all
selected, click on the Save Set button
to save them as a separate file on your
hard drive. Loading the preset file later
on is as simple as clicking the Load
button and navigating to your saved
preset file.
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22 Use the Move tool to click on the painting.jpg canvas and drag it into your
working file as a new layer while holding down the Shift key. Holding down the Shift
key ensures that it lands in your file in the proper position. Ensure that the new
grayscale paint layer is at the top of the Layers palette and change the blending
mode of the layer to color burn. Reduce the opacity of the layer to 14%, and you'll
see that a surface texture effect is beginning to take shape as the colors on the
underlying layers become darker and more saturated.
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23 Now duplicate your painting layer by

duplicated layer to soft light to intensify the

surface texture effect within the image.

Examining your technique

Now that you're finished, let's take a closer look at some of the things that make this the ideal process for painting digitally.

£ e o
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a When you customize your own brushes, and especially when you
create your own brush tips from images, saving your tool presets is a
very good idea because it ensures that they are always available to you.
And saving them as a preset library file ensures that you can access
them at any point later on, within this or any other Photoshop file.

b Building up your own custom swatches in the Swatches palette is
the digital equivalent of a handheld painter’s palette. Your colors will
always be available to you here. Choose the Save Swatches option

from the Swatches Palette menu to save them as a
file on your hard drive.You can load them or replace
an existing set of swatches by choosing either option
from the Swatches Palette menu and navigating to
your saved file. Swatches can also be saved or loaded
in the Preset Manager.

¢ Keeping different elements and different stages in
the process separated on a series of layers allows

you enough flexibility to revisit things later and alter
them. You can target individual layers and edit or mask
their contents. Also, you can insert adjustment layers
between layers to affect only certain portions of the
composition.

d Using a real-world surface texture is an excellent
way to add another level of authenticity to your
painting. The simple grayscale scan used here on

a series of layers helps to remedy the ultrasmooth
digital canvas surface, making it more realistic in
the end.

dragging it onto the Create a New Layer button
at the bottom of the Layers palette. Change the
blending mode of your duplicate layer to vivid
light and increase the opacity to 35%. Finally,
duplicate your current painting copy layer and
then change the blending mode of the recently

17
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A more realistic approach

This method of painting is certainly not limited to the subject matter or rough style that was covered previously in this
chapter.You can apply this method to the subject of your choice and paint in any style that comes naturally. Here | decided to
give traditional portraiture a try. Rather than starting with a sketch, | placed a photograph on an underlying layer and used it
as a guide while | was working. Unlike the sketch, it proved to be too distracting if it was visible the entire time. So | simply
enabled the visibility of the photo periodically to stay on track. Another thing to consider when you're after a more realistic
approach is the fact that you'll need to spend a lot more time blending colors together to make smooth, seamless transitions.

18
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Virtual life drawing
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Rather than sitting in a studio with charcoal, paper, and an actual model, why not replicate the process on your laptop
or PC? I launched Poser and rendered a male figure using the pose shown here and a couple of colored lights. | then
rendered the file and opened it in Photoshop. This acted as my base layer. Then, | employed the techniques explained on
the previous pages across a series of layers to create this impressionistic figure painting.

19






Chapter 2

Creating
Characters with
Shape Layers

hen it comes to creating flat, sharp, and colorful characters in Photoshop, it is

always advantageous to involve the use of vectors. Vectors are mathematical

objects that define shapes or curves. Unlike pixels, vectors are resolution inde-

pendent. This means that they can be scaled to any size, edited, or transformed an
infinite amount of times without any deterioration of clarity or loss of detail. In Photoshop, vector
art can be integrated into your image files in the form of paths, vector masks, or shape layers.

Different vector tools and functions are suited to a variety of tasks in Photoshop. In our case,
the creation of whimsical character faces is ideally suited to working with shape layers. A shape
layer can be created with the Pen tool or any of the shape tools. What causes one of these tools to
create a shape layer, rather than a path, is the designation that you choose in the Tool Options bar.
Shape layers allow you to build up stacks of resolution-independent shapes that are absolutely
perfect for tasks like creating faces. The available preset shapes are excellent building blocks for
features and the Pen tool affords you the flexibility to create any custom shape you desire.

Once you create a number of shape layers, the flexibility doesn’t end there. When you
select more than one shape on a layer, you’ll notice that there are a number of options available
for creating compound shapes. You can add, subtract, intersect, and exclude shapes as well as
perform a plethora of alignment options to get your complicated features placed exactly where
you want them on the face.

Like traditional layers, shape layers can also be linked or grouped so that multiple elements
across a series of layers can be moved, rotated, or scaled together at the same time. No matter
what style of face you’re creating, when it comes to flexibility and versatility, shape layers are the
absolute key to success.

DUSI[AVIRR @ You'll need a basic understanding of how to draw and edit Bezier curves. A
slight familiarity with shape or path area operations will make things easier.

2 0 OI 5 Knowledge of the basic differences between tools like the Path Selection
tool and the Direct Selection tool will be beneficial.




What you’ll learn in this chapter

Creative Techniques and Working Methods

Photoshop Tools, Features, and Functions
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Creating from virtually nothing

Building a character like those shown here is the result of piecing together the
right ingredients and knowing just how to edit select components to make them
unique. The predefined shapes we’ll use are basic. The shapes we'll create with
the Pen tool are nothing extravagant. However, the method of construction and
the ability to visualize the result are important. As you work your way through the
chapter, the logic will fall into place and you'll get a feel for how simple regions
of sharp color, on a series of layers, can act together to create an expressive
character with a unique personality.

Cut your work in half

Obviously, details like eyes or antennas are things that appear more than once on
the face. Just because there are two eyes or two antennas, it doesn’t mean that
you must carefully construct each instance. You'll learn how to logically group the
shape layers that make up each feature, duplicate them, and flip or alter specific
details to make these features look as if they belong together on the face or head.

m a- e Duplicate shape layers
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Shape layers are wonderful and flexible resources. However, it is important not to
underestimate the potential that lies within existing shape layers. In this chapter, you'll
learn how to duplicate shape layers and edit them with a clear intent to make something
entirely new out of them. Using them as building blocks for new shapes can provide you
with a starting point that already has part of the work done for you.

Area operations

Whether you want to combine two shape components together or use one shape to punch a
hole in another, shape area operations are an essential part of the procedure. The results
will be neater and more versatile when you use basic shapes and area operations together
rather than trying to draw the resulting shape on your own.
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PART ONE: The first character

1 The first thing you need to do is open up

the background.jpg file. This brightly colored
painting provides an ideal backdrop for the
bright, whimsical characters we're about to
create in this chapter. All of your shape layers
will be added to this file to create a plethora of
strange creatures. To get started, select the Pen
tool. Then, in the Tool Options bar, ensure that
the Shape Layers function is enabled. Do this
by clicking on the button at the left. Press “d”
on the keyboard to set your foreground color
to black and zoom in closer on a section of the
background.

=]

@] Project files

All of the files needed to follow
along with this chapter and create
the featured image are available for
download on the accompanying Web
site in the project files section. Visit
www.creativephotoshopthebook.com.

Q‘
T‘
k Path Selection Tool A

ﬂ. Q Direct Selection Tool A
2 Click and drag with the Pen tool to create a curved point. Move the mouse, then
click and drag again to create another curved point joined to the previous point
by a line segment. Repeat this method, making your way back to the original point.
Click and drag on the original starting point to close the shape. Once the shape is
closed, select the Direct Selection tool. Use the Direct Selection tool to click on the

individual points that make up your curved shape. When you click on a point, the
Bezier handles that define that point will become visible.

23
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3 Click and drag the Bezier handles to reshape
the curves and move the points with the Direct
Selection tool until you have achieved the
desired shape. When you're finished, select the
Pen tool again and click on the Foreground
Color swatch in the toolbar to launch the picker.
Choose a blue color from the picker to change
the foreground color to blue. Ensure that the
Create New Shape Area option is selected in

the Tool Options bar, and then use the previous
method to create a smaller blue shape on a new
layer. Edit the points and curves with the Direct
Selection tool using the previous method.

@ Affect which shape layer?

You've probably noticed by now that
before you create a shape layer, |
instruct you to set the foreground
color in the toolbar first, specifying

a fill color for your new layer before
you create it. However, you've probably
noticed that there is a Golor swatch in
the Tool Options bar that allows you to
specify the fill color of a shape layer
too. Before you choose a different color
from the swatch in the Tool Options
bar, you need to pay attention to a
small Ghain-Link button to the left of
it. When enabled, this option affects
the properties of the current layer, the
layer you already created. So when this
option is enabled, changing the color
in the Tool Options bar will affect your
already existing layer. If you disable this
option, your current shape layer will
remain unaffected when you choose a
new color. But any new shape layer you
create will use the new color selected
in the Tool Options har.
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4 Specify a darker blue foreground color. Select the Pen tool and ensure that it is
set to create a new shape layer in the Tool Options bar. This time, when starting
your shape, just click once instead of clicking and dragging, then move the mouse
and click and drag. This will create an initial sharp or corner point, and your
second point will define the curvature of the line. Click and drag to add more
curved points and then, when returning to your starting point, just click. By clicking
once on the starting point, you ensure that this point remains sharp, not curved.
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6 Drag the shape layer onto the Create a New Layer button in the Layers palette
to duplicate it. Target the original layer (the one beneath the copy) in the Layers
palette. Choose Edit > Free-Transform from the menu and drag the corner points
of the box outward to increase the size, and alter the shape of the shape layer.
Press the Enter key to apply the transformation. In the Tool Options bar, enable the
Chain-Link button to affect the current layer. Then specify a black fill color via the
swatch in the Tool Options bar.
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5 In the Tool Options bar, select the Ellipse
tool and then disable the Chain-Link button by
clicking on it, so that the new color we choose
from the swatch in the Tool Options bar is not
applied to the currently targeted shape layer.
Glick the Color swatch in the Tool Options bar
and select a dirty yellow color from the picker.
Ensure that the Create New Shape Layer option
is enabled and then click and drag while
holding down the Shift key to create a perfectly
circular shape layer.You can reposition the
entire shape layer with the Move tool.

@ Which tool do | use?

Using the Move tool will allow you to
move an entire shape layer around on
the canvas. However, if you want to move
your shapes around within your layer,
you'll need to use the Path Selection
tool. Simply click on the shape you
wish to move and drag it with the Path
Selection tool. This is especially useful
when your shape layer contains more
than one shape and you wish to move
shapes independently of each other.
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7 Target the top layer in the Layers palette so that your next layer will be created above it. Again, use the Ellipse tool to draw a smaller
circle in his eye area. Ensure that the Create New Shape Layer option is enabled as you create the circle. Next, change the fill color of
the new layer to red via the Color swatch in the Tool Options bar. With this new layer targeted, choose the stroke effect from the Layer
Styles menu at the bottom of the Layers palette. Add a darker red stroke to the outside of the circle.
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Finish, group, duplicate, and flip
Complete the eye area and add a cheek detail. Then flip the artwork to the other

side of his face.
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1 Use the same methods to create two
new shape layers: one containing a black
pupil shape and another containing a
purple cheek shape. Target all of the eye
and cheek shape layers in the Layers
palette. Type Control(PC)Command(Mac)-
g to group them.

b Twougn ) Omscey: 10 8]
Js+e -
® b | oyeand chesk copy

W b 0 e and chest

= O sl
- .i-u—

.nm a
CEE K]

Leek

2 Select the Move tool and ensure that
your group is targeted. Hold down the
Alt(PC)/Option(Mac) and the Shift key
as you drag the artwork to the right side
of his face creating a duplicate of the
group, aligned horizontally.

3 Choose Edit>Transform>Flip
Horizontal from the menu to
horizontally flip your duplicated
group. Expand the duplicated group
in the Layers palette and target

the red iris layer. Shift-drag to the
right on the canvas with the Move
tool. Repeat this process with the
duplicated pupil shape layer. This will
remedy his cross-eyed appearance.
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8 Collapse the group in the Layers palette. Use the Eyedropper tool to click on the dark blue area around his eye, sampling it as the
current foreground color. Use the Pen tool to create a new shape layer in the middle of his face. Carefully draw a nose shape with

the Pen tool. Take your time, clicking once to create sharp points, clicking and dragging to create curved points. Edit the shape with the
Direct Selection tool wherever necessary. Next, select the Ellipse tool and draw a lighter blue ellipse over his nose on a new shape layer.

Subtracting and combining shapes
Now we’ll explore how multiple shapes can be used together within a single shape layer, producing a nice nostril highlight at
the same time.
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1 Select the Ellipse tool, and select
the Create New Shape Layer function
in the Tool Options bar. Create a light
blue ellipse on the canvas, over his
nostril, as a new shape layer. Use the
Path Selection tool to reposition it if
necessary.

2 Use the Path Selection tool to drag

the shape to the right and down a
little while holding down the Alt(PC)/
Option(Mac) key, duplicating it. With
the duplicate shape selected, click o
the Subtract from Shape Area button
in the Tool Options bar.

( Combine ]

3 Click the Combine button to create
a single shape resulting from

the subtract operation. Alt(PC)/
Option(Mac)-drag this shape to the

n right with the Path Selection tool.
Choose Edit>Transform Path>Flip
Horizontal from the menu. Press Enter
and adjust the positioning of the
flipped duplicate shape if necessary.
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9 Set the foreground color to black. Select the
Pen tool and ensure that the Create New Shape
Area option is enabled. Draw a closed shape

to indicate his mouth. Click and drag to create
a series of curved points and use the Direct
Selection tool to edit your points and curves
until the mouth shape is looking just right.
Duplicate the mouth shape layer in the Layers

palette so that there are now two of them. Target

the duplicate mouth layer and press the Link
button in the Tool Options bar so that when you
change the color, this layer will be affected.

Switching to a
selection tool

When you are working with the Pen
tool, you can temporarily switch to
the Direct Selection tool by holding
down the Control(PC)/Command(Mac)
key. When you are working with

a shape tool, holding down the
Gontrol(PC)Command(Mac) key will
temporarily switch your tool to the
Path Selection tool. Releasing the
Gontrol(PC)Command(Mac) key will
revert back to your original tool.
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10 Click the Color swatch in the Tool Options bar. When the picker opens, move the
mouse out over the yellow part of the eye on the canvas and then click to select
this yellow as the fill color for this shape layer. Click OK and select the Pen tool.
Choose the Intersect Shape Areas option in the Tool Options bar and then draw

a closed shape that contains two fangs that overlap the mouth area. As you draw,
you'll see the layer content disappear and then only reappear in areas where the
new shape overlaps the existing shape within the current shape layer.
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12 If the Chain-Link button is enabled in the Tool Options bar, disable it. Then click
on the Golor swatch in the Tool Options bar and select black from the picker. If you
do this while the Chain-Link button is enabled, it will change the color of your tongue
shape layer. Disabling it ensures that only a new shape layer will contain black.

Also, ensure that you set the style setting back to none; otherwise, the next layer you
create will have the previous layer’s stroke style applied to it. Use the Pen tool with
the Create New Shape Layer option enabled to draw a forehead wrinkle shape.

Chapter 2: Creating Characters with Shape Layers

11 Use the Pen tool with the Create New Shape
Layer option enabled to draw a tongue shape on
a new shape layer that sits within his mouth on
the canvas. Click the Color swatch in the Tool
Options bar and when the picker opens, click on
the red area of one of his eyes in the image to
specify that as the fill color for your new shape
layer. Expand one of your groups in the Layers
palette. Find one of the layers with the stroke
effect applied to it. Hold down the Alt(PC)/
Option(Mac) key and then drag the effect from
that layer onto your new layer, copying it.

@ Combining shape
components

The shape area functions in the Tool
Options bar provide nearly everything
you need to create diverse and unique
composite shapes. However, there

may be instances where you wish the
visible results were indicative of one
actual shape or perhaps you wish to
perform different shape area functions
on the resulting shape. In these cases,
simply click on the Combine button

in the Tool Options bar to change the
group of shape components into a
single, editable shape. Be cautious
when combining because once you
combine the shape components,

they are no longer editable as
separate components. If you keep the
components separate you still have the
option of altering the physical qualities
of the shape as well as changing any
shape area functions applied to your
individual shapes.
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Custom shapes

@

When you have spent some time
creating a shape of your own with the
Pen tool or by editing a preset shape,
you may wish to save it for use later
on.To do this, simply select the shape
with the Path Selection tool and choose
Edit>Define Custom Shape from the
menu. This will allow you to name the
shape and save it. The next time you
select the Gustom Shape tool, your
custom shape will appear in the list
of presets available in the Tool
Options bar.
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13 Now select the Add to Shape Area function and draw some more closed shape
components to indicate wrinkles on his forehead and the left side of his face. Use
the Path Selection tool to select one of the wrinkle shape components that you
created at the left. Then, hold down the Shift key and click on the other wrinkle
shape components at the left to select them as well. While holding down the
Alt(PC)/Option(Mac) key, click on the selected shape components and drag them
to the other side of the face, copying them.
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14 Now, to flip your duplicated wrinkles over, choose Edit>Transform Path>Flip
Horizontal from the menu so that they look like they belong on the right side of the
face. Reposition them if necessary with the Path Selection tool.Your top layer is
currently targeted in the Layers palette. Hold down the Shift key and click on the
shape layer directly above the background layer. This targets the new layer, the top
layer, and all layers and groups in-between. Now choose Layer>New>Group From
Layers from the menu to add all of the targeted contents to a single group.
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17 Add a stroke effect to this layer. Use a darker green color, a generous thickness,
and position it outside so that it surrounds the exterior of the shape components.
Select the rounded rectangle shape tool in the Tool Options bar. Set the radius very
high. Then click and drag to create a tooth shape on a new shape layer. Change

the fill color of the layer to light yellow. This layer automatically has the previous
stroke effect applied to it. Double-click the effect in the Layers palette to edit it,
reducing the size of the stroke.

Chapter 2: Creating Characters with Shape Layers

15 It is likely that by now you are becoming
familiar with the process of creating new shape
layers. So let's put that familiarity to work again.
Navigate to another area of the canvas. Use the
Pen tool, set to Create New Shape Layer to draw
the shape of an alien’s head. Don’t worry about
the fill color of your layer at this point. Next,
select the Add to Shape Area option in the Tool
Options bar. Draw an ear at the left of his head.
Then use the Path Selection tool to Alt(PC)/
Option(Mac) + Shift-drag his ear to the other
side of the head, copying it.

16 Flip the copied shape component horizontally
via the same methods you've previously used for
flipping other shape components. Use the Path
Selection tool to position it exactly where you
want it on the layer. Now, double-click your shape
layer thumbnail in the Layers palette. This will
launch the picker. Choose a new, light green fill
color for your layer and click OK.You can change
the fill color of any shape layer at any point by
double-clicking the layer thumbnail. As you can
see now, there are numerous ways to specify and
edit the fill colors of your shape layers.

Changing the fill color

Another way to quickly change the fill
color of a shape layer is to start by
targeting a shape layer in the Layers
palette. Next, choose a foreground color
from the picker. Then type Alt(PC)/
Option(Mac)-Delete on the keyboard to
fill the layer with the new foreground
color.
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